Implement a data growth solution using InfoSphere Optim 11.3

Learn to manage data growth effectively to reduce costs and improve performance

Pirabu Pathmasenan (pirabu@ca.ibm.com)  
IBM Analytics Consultant, DB2 LUW and InfoSphere Optim  
IBM

Martin Dizon (mdizon@ca.ibm.com)  
Optim/Guardium Specialist  
IBM

16 April 2015

Readers for the first time can explore the new data growth architecture and self-service features of InfoSphere® Optim™ 11.3 for all their enterprise-wide data growth and application retirement needs. We will showcase a step-by-step approach of how to use InfoSphere Optim 11.3 to archive, browse, delete, and restore data from enterprise applications. In addition, we will provide a detailed look at how to use InfoSphere Optim's new On-Demand archiving capabilities using Optim Designer and Manager.

Introduction to data growth

As today's enterprise data grows rapidly, large databases use more disk space and produce slower response time, which in turn affects the performance of mission critical applications. With InfoSphere Optim Archive, enterprises can easily manage enterprise data using the Optim archiving strategy. The concept of an archiving strategy is quite simple: You archive old, rarely accessed data and subsequently remove the archived data from the database. At the same time, recent or important data stays in the production databases to serve mission-critical operations while retaining optimal performance. Therefore, with archiving, enterprises can effectively streamline large databases and optimize the performance of mission-critical applications.

InfoSphere Optim Archive helps organizations:

- Manage the growth of application data and data warehouses for better data control and reduced storage costs.
• **Apply business rules and criteria** to segregate and archive historical data more safely and improve compliance.

• **Improve data lifecycle management** for more efficient storage processes.

• **Use a single scalable solution** across applications, databases, data warehouses, operating systems and platforms.

• **Assess dormant data** to identify data that should be archived through capabilities of InfoSphere Guardium® Data Analyzer.

IBM InfoSphere Optim Archive includes the following features:

- **Archive**— Archive related sets of data from your database while retaining access to archived data for compliance, analysis, or reporting purposes.

- **Browse**— Provide a way to browse your archived data without restoring it to a database. You can use this feature to verify your archived data before deletion or restoration, or even to respond to inquiries without restoring data to a database.

- **Delete**— Delete a complete set or subset of archived data from database. The delete process can be executed as part of the Archive process, or deferred at a later time after you have browsed and verified the archived data.

- **Restore**— Restore complete set or a selection of archived data to the source database or to another database. You can restore to the same database even though the data model is changed; or restore to a staging database for analysis and reporting purposes.

### InfoSphere Optim data growth scenario

Let's assume the following: You are a DBA at a wholesale DVD company that sells DVDs to retail video stores. The database landscape of your company consists of two production databases, which supports online retail transactions. The federated production environment entails one DB2 database containing the main business data and one Oracle database containing the customer shipment information. Your company is facing a problem where the DVD business is growing bigger every day, and the accumulated large amount of data in the production database is affecting the performance of the mission-critical application and daily operations. Your company has decided to archive all customer orders older than six years based on the evaluation of the data access on a day-to-day basis.

In order to keep the complete business object intact, we want to archive all customer information, their orders made, the details of each item that have been purchased, the delivery ship-to information, and the shipping instructions information associated with each customer.

We have a federated production environment including DB2® and Oracle tables, as illustrated below. In order to achieve the complete Data Growth scenario, the relationships required to work with the federated data environment will need to be created. We will create a cross-database relationship between OPTIM_CUSTOMERS and OPTIM_SHIP_TO in the Optim directory. We will also create a parent-to-child relationship of OPTIM_SHIP_TO to OPTIM_SHIP_INSTR. The dashed lines in the diagram below represent the new Optim relationships.

Therefore, based on the Data Growth scenario and the relationships between DB2 and Oracle, we will want to archive the OPTIM_SALES, OPTIM_CUSTOMERS, OPTIM_ORDERS,
OPTIMDETAILS, OPTIMITEMS, OPTIMSHIP_TO, and OPTIMSHIP_INSTR tables. All the tables referenced in this tutorial are the sample tables shipped with InfoSphere Optim 11.3, which can be installed onto your database when configuring an Optim DB Alias.

**Figure 1. Relationship between DB2 and Oracle tables**

After archiving the data, we shall browse the archived data to verify that we have archived all orders older than six years, and verify if it is appropriate to delete the data from the production database. When the archived data is verified, we can streamline the production database by removing the archived data. In this scenario, we will only delete a subset of archived data from OPTIM_ORDERS and their associated OPTIMDETAILS since they are out-of-date and accessed less frequently.

At the end, we assume that a customer has called to inquire about an old order that has been archived. We will restore this particular order with its associated detail from the archived file back into the database so that the customer service representatives can look into the order details and process the customer’s inquiry.

**Connecting to an Optim directory & DB aliases using Optim Designer 11.3**

For the purpose of this tutorial, lets assume that InfoSphere Optim 11.3 solution is installed and configured on Windows. Open Optim Designer 11.3 from Windows desktop and always remember to run the Optim solution as an Administrator on Windows 7 and above.

Once Optim Designer is launched, you will be asked to connect to Optim Connection Manager. InfoSphere Optim Connection Manager is a web application that stores Optim directory connection information for InfoSphere Optim components. InfoSphere Optim Connection Manager is also known as the connection manager.

Enter the following authentication information in the Optim Connection Manager window:
User name: admin
Password: admin

Optim Connection Manager would automatically connect to the Optim Directory. To ensure that the Optim Directory is successfully connected, make sure that there is a green check mark next to OPTIMDIR. OPTIMDIR is the name of our Optim Directory (for the purpose of this tutorial). Expand the Data Store Aliases to see the currently configured DB aliases. You will notice that there are three DB aliases already configured for the purpose of this tutorial and none are currently
connected to. We will be mainly using SOURCEDB and XE DB aliases to showcase the archiving capabilities of InfoSphere Optim 11.3.

**Figure 2. Directory explorer showing Optim directory and DB aliases**

Right-click on SOURCEDB and select Connect. Once you have successfully connected to SOURCEDB, repeat the steps for XE.

Once both DB aliases are successfully connected to, expand the SOURCEDB and XE database and check the Optim Schema for the pre-loaded Optim sample tables and their definitions.

**Creating relationships across federated DB environments**

In this section, we will create relationships across the federated database environments so we can build our complete business objects needed to build an Optim Access Definition.

First, we will go through how to create the federated relationship between OPTIM_CUSTOMERS and OPTIM_SHIP_TO - we will name this relationship CUSTSHIPTO. Right-click Optim Relationships and Select New Optim Relationship.

**Figure 3. New Optim relationship**

Select SOURCEDB as database for the parent table and choose NEXT. Now enter Optim.% in the Table search pattern search bar and click Display Tables. Once the tables are populated in the results section, select OPTIM_CUSTOMERS table as the parent table and click NEXT.
Implement a data growth solution using InfoSphere Optim 11.3

Figure 4. New Optim relationship — Selecting a parent table

Now select XE as the database for the child table and click NEXT. Enter `optim.%` in the Table search pattern section of the search bar and click **Display Tables**. Once the tables are populated in the results section, select `OPTIM_SHIP_TO` table as the child table and click **NEXT**. Now to successfully create the new Optim relationship, enter the following for this DB2 to Oracle Relationship and click **FINISH**:

**Name:** CUSTSHIP_TO  
**Description:** Optim_Customer to Ship_TO Relationship

Figure 5. New Optim relationship — Entering a relationship name

Now inside the Relationship Editor Pane, right-click inside the **Expression mappings section** and choose **Add Expression**. This allows us to select a column from the parent table and link it with a column from the child table to build the relationship. In our case, we will select CUST_ID as the column from both Parent column and Child column and click **OK**.
Figure 6. New Optim relationship — Adding an Expression Mapping

Ensure that the relationship is saved by choosing File and selecting Save All. Next, we need to create the relationship between `OPTIM_SHIP_TO` and `OPTIM_SHIP_INSTR`; this relationship will be called `SHIPTSHPI`. The steps are similar to the `CUSTSHIPTO` relationship, but this time we will choose `XE` as the database for our parent table and enter `optim.%` in the Table search pattern search bar and click Display Tables.

Once the tables are populated in the results section, select `OPTIM_SHIP_TO` table as the parent table, then click NEXT. We will once again select `XE` as the database for our child table. Enter `optim.%` in the Table search pattern search bar and click Display Tables. Once the tables are populated in results section, select the `OPTIM_SHIP_INSTR` table as the child table and click NEXT. As before, provide a meaningful name to save the relationship. Now in the Relationship Editor pane, right-click inside the Expression mappings section and choose Add Expression. This time, we will choose `SHIP_ID` as the column for both Parent column and Child column.

Figure 7. New Optim relationship — Adding an Expression Mapping

Check the Relationship Editor to ensure that the status is OK, meaning that the relationship was successfully created. Always remember to choose File > Save All to save all your changes inside Optim Designer.

Creating an Optim archive access definition

An access definition is a declaration that identifies the start table, related tables, relationships, and selection criteria that define the data to be processed. An Optim access definition can be used to:
• Identify the tables from which data is archived in the archive process. You can insert the name of a single table and request that Optim reads and provides the names of all related tables. One table is identified as the start table, or table from which data is first archived.
• Identify tables from which data is deleted after archiving. You can set an option to review and change your selections before data is deleted.
• Select relationships to be traversed and the direction of traversal when archiving the data.
• Define criteria for the set of related rows to be archived, either as selection criteria based on the age of the data or values in one or more columns or as a manually selected list of start table rows (known as the Point and Shoot option).
• Set up indexes to be created when data is archived.
• Establish archive actions to be run when data is archived or restored.
• Review how Optim traverses the database to ensure that the correct data is archived.

Before we create an Optim Access Definition, let’s rename the folder from PSTDEMO to something more meaningful. Right click on the PSTDEMO folder and choose Rename. As a best practice, it is recommended that you rename the project folder to name of the project that you are currently working on. For the purpose of this tutorial, we will rename the project folder to InsightDG.

**Figure 8. Renaming the project folder**

Expand the newly renamed InsightDG folder. We will create an Access Definition to define the data to be archived. For the purpose of this tutorial, we will build an Access Definition to archive orders older than six years. Right-click Access Definitions and select New Access Definition. Enter in a meaningful name for the Access Definition Name and click NEXT. Select SOURCEDB as the DB alias for your start table and click NEXT. Enter Optim.% in the Table search pattern search bar and click Display Tables. Once the tables are populated the results section, select the OPTIM_ORDERS table as the start table and click NEXT. Select Find Related tables and click Display Tables and ensure that the BOTH option is selected. Once all the related tables are populated, click Select All > FINISH. The Access Definition Editor will open in the right pane of Optim Designer, so select OPTIM_ORDERS (start table) and click Add Table Specifications.
To determine orders which are older than six years, we will use the Optim built-in function BEFORE (nD,nW,nM,nY), where D, W, M, and Y indicate the number of days, weeks, months, and years before the current date. So, now in the SQL Where clause field on the Table Level tab, enter `ORDER_DATE BEFORE(6Y)`.

This will include all rows in the OPTIM_ORDERS table with an ORDER_DATE before six years from the current system time to be in the archive. Click **APPLY**.

In the table specification editor, you also have the ability to add an index to the archive by switching to the Archive Index tab to define an archive index for our Archive file. Having an Archive Index file is useful when you search data from Archive files, Optim will check to see if it can use an Archive Index to speed up the search. We will create an Archive Index on ORDER_ID, choose
ORDER_ID from the Eligible Column side and add \texttt{ORDER_ID} to the Index Column side. Click \texttt{APPLY > OK} to proceed.

**Figure 11. Table specifications — Archive index**

Now we have successfully added a Selection Criteria and Archive Index to our \texttt{OPTIM_ORDERS} start table. Next, let’s define the data that we would like to delete once the archive is complete. In our scenario, we want to delete the archived data from \texttt{OPTIM_ORDERS} and \texttt{OPTIM_DETAILS} tables of the production database, while keeping the data from all the other related tables in production since this data is relevant to the current business operations.

To specify the data to delete, click the \texttt{OPTIM_ORDERS} table and under the Table Details option tab, check the Delete after archive checkbox. Select the \texttt{OPTIM_DETAILS} table and under its Table Details option tab, check the same Delete after archive checkbox. This specifies the tables you intend to delete after a successful archive.
In the same window, scroll down and choose the Transversal Options tab. We want to ensure that both options 1 and 2 are selected for transversal options. By selecting transversal Option 1, Optim will ensure that if a child row is selected, Optim will include its parent row to ensure referential integrity. And by selecting transversal Option 2, Optim will ensure that if child rows are selected, a parent row is included in a path from child to parent. Save all your definitions changes by selecting File > SAVE ALL.

Creating an Optim archive service using Optim Designer 11.3

In this section we will look at how to create an Archive Service to run the actual data archive. Right-click on Archive Service and select New Service.
First, you will need to give a meaningful name for the new Archive Service and choose Archive as the Service Type. Click **NEXT**.

In the next window (Select an access definition), we will choose the Access Definition we previously created (DG.ORDERS6Y) from the populated list and click **NEXT**.

In the following window, enter a name for the Archive File name and click **FINISH**. For the purpose of this tutorial, we will name the Archive file **ORDERS6Y_AF**. Now in the Archive Service Editor pane, switch to the Server and Files tab and use the drop-down to switch the server from (Local) to WIN-RNTCM0CMQ7A. This is the name of our Optim Server, which has already been configured and running. Under the Group field, enter **ORDERSGP** as group name. Group acts as a tag so you can associate Archive files for future search criteria purposes.

**Figure 14. Archive Service Request — The Archive Service Editor**

![Archive Service Editor](image)

Now, switch to the Delete tab and ensure that Defer delete after archive is checked. This option allows you to delay the deletion of the archived rows, giving you an opportunity to verify the archived data before the data is deleted from the database. We will show the full delete process in a separate section.

**Figure 15. Archive Service Request — Archive Service Editor showing the delete option**

![Archive Service Request](image)

Finally, switch to the File Options tab and ensure that the Compress target file and Compress archive index file options are checked. These will ensure that our Archive file and Archive Index file are compressed using Optim's compression mechanism. Save all your Archive Service changes with **File > Save All.**
Running an Optim archive service using Optim Manager 11.3

The Optim Manager is the operational client. Its purpose is to manage, schedule, and execute Optim Services once they are ready for production. It is a web application that provides the necessary functionality to execute and monitor any Optim Services that have been saved to the Optim Repository. Please ensure that your Optim Server is started and running, as this tutorial will assume that you are using an Optim Server to execute all archiving related services. The Optim Server used here is on Windows.

Open Optim Manager 11.3.0. Once the Optim Manager web console opens, enter the following into the log-in screen and click Log In. Username: admin Password: admin

Switch over to the Configuration tab to check the status of the Optim Server. Under the Status field, ensure that it reads ONLINE, which indicates that your server is successfully up and running. Next, switch to the Service Management tab and locate the Archive Service we defined and created in Optim Designer. In our case, select the DG.SVORDERS6Y service and click RUN. Review the service information carefully on the next pop-up window and click RUN.

Once the Archive Service is kicked off, switch to the Service Monitoring tab to check the status of your Archive service job, which should read In-Progress. This shows that the Archive job is currently running. Once the status of the job changes from In-Progress to Successful, it indicates that the Archive job has completed running and you are now ready to view the results of the Archive Service.

Figure 16. Optim Manager — Service monitoring for the Archive Service

Now we are ready to view the results of the Archive Service. Click the link that says Click here to view full report for DG.SVORDERS6Y in the Service Summary section to view the full details of the Archive service that just ran. The report will open in a new tab and will give you a detailed...
summary of the Archive service that was just executed by Optim Manager. Since we will be performing other Optim-related services for this tutorial, minimize your Optim Manager browser and maximize your Optim Designer window. Do not close the Optim Manager Browser.

Verifying an Optim Archive service using the InfoSphere Optim Browse utility

Inside Optim Designer, locate the BROWSE Utility and click on it to open it. The Optim Browse utility will provide a way for you to browse your archived data without restoring it to a database. When the Browse utility opens, locate your Archive File and open it. The Browse utility will open your archive file in a format you can visually comprehend and read. The table names will be displayed on the left, and the total number of rows archived from that table will be displayed on the right.

We will browse the OPTIM_ORDERS table to take a more detailed look at the rows archived. The OPTIM_ORDERS table will open a new window called Browse Archive File Table Data.

As a best practice, it is good to query the database to see if the data we archived is in fact that data we intended to archive. This can be archived by directing connection to the production database and running some queries against the data to ensure that the row counts match.

Creating an Optim Delete Service using Optim Designer 11.3

Using the Optim Delete Process, you can choose to delete a complete or subset of archived data from the database. There are two ways to delete data for an Archive:

- **As part of the Archive Process** — The selected set of data will be deleted from the database right after archiving.
- **Defer Delete after Archive** — The selected set of data can be deleted from the database using an independent Delete Request (this is the method we specified in the Archive Service section).

When Optim deletes data from the database, it will match the archived rows from the Archive File to the corresponding rows in the database. If the rows have been altered from the database since the last Archive, the deletion will be skipped for that row. This ensures that the data being deleted is the data that we have archived.

Recall that we will only be deleting data from the OPTIM_ORDERS and OPTIM_DETAILS table which are part of the SOURCEDB database (DB2 database).

Now in Optim Designer, inside the Directory Explorer go to your InsightDG folder, Right click on **Delete Services** and select **New Service** to create a new Delete Service. You need to enter a meaningful name for the Delete Service and select **Delete** as the Service Type, then **NEXT**. Now, ensure that the Locate file in Optim directory option is selected, and in the Filters section, ensure that the Archive option is selected. Click on **Display Files** to populate a full list of all your archive files from your Optim Directory. Since we have done only one archive service, you should be able
to see only one archive file in the populated list. Select the ORDERS6Y.AF Archive File and click FINISH.

**Figure 17. Delete Service — Selecting a source archive file**

Now the Delete Service Editor window will open on the right pane of Optim Designer. Go to the Server and Files tab and switch the server from (local) to WIN-RNTCM0CMQ7A. Next, switch over to the Strategy tab and ensure that under the Compare Row Contents field for each table, it shows Compare — include LOBs. This will ensure that Optim does a row-by-row comparison to the data in the Archive file to the rows in the database prior to deletion. Rows are only deleted from the database if it exactly matches the corresponding rows in the Archive file. Rows that do not exactly match are discarded and recorded in the Control File.

Save all your Delete Service-related changes by going to File > Save All. As another best practice before actually running the Delete Process, take a minute check the total rows counts in the tables you will be deleting, so that once the deletion process is complete, you can query the tables again to ensure the correct number of rows were deleted.

**Running an Optim Delete Service Using Optim Manager 11.3**

Reopen the Optim Manager browser window and select the Service Management tab to see your newly created Delete Service. Select your Delete Service; in this case, the name of the Delete Service is DG.DELORDERS6Y. Click the Assign Server button to assign a Server for this Delete Service. Initially, there won’t be any server assigned to any new jobs, as customers could typically have more than one Optim Server available for Optim services. Once an Optim Server is assigned, the state of the Delete Service should be in the Ready state and ready for execution. Next, select your Delete Service and click RUN and RUN again on the next pop-up window. Once the delete service is complete, you can open the report to view the full details about the data that was deleted from the production SOURCEDB database.
Once the report is opened in the new tab, scroll down to view the Process Summary section and the Process Details section, and you will see all the information regarding the delete service. Carefully take some time to read through each of the other sections of this delete service report, as it will provide other cost-savings benefits from this delete process using InfoSphere Optim. Once you are done reviewing the delete service report, close the report and minimize the Optim Manager Browser window for now (do not close it).

As a final step of verification, make a connection to your database and see if the correct numbers of rows were removed from the database from the archived tables.

Creating an Optim Restore Service using Optim Designer 11.3

Using the Optim Restore Process, you can restore the complete or subset of Optim archived data to the original or a staging database. There are two ways to restore data:

Load

- For large volume of data, faster performance than INSERT.
- May require an exclusive lock on the database during a Load Process.
- Either Inserts or Replaces existing data in database.

Insert

- Insert Process execute INSERT SQL statements to the database, performance not as good as LOAD.
- Database is available to other users during Insert Process.
- Insert/Update processing in one step.

For this Optim Restore scenario, let’s assume an old customer called to inquire about several of his old orders, which have been removed from the production database. The customer service manager wishes to keep this old customer and is willing to analyze the old orders. Therefore, the manager requested the DBA to replace the order details back into the production database.

We know that his ORDER ID is 9146, so the DBA will restore the respected order and its details back into the OPTIM_ORDERS and OPTIM_DETAILS tables of SOURCEDB database.

We will first need to create an Optim Table Map inside Optim Designer. A table map identifies and matches two tables or sets of tables in an insert or load process that is used in a restore process. A table map can also exclude one or more tables from processing. To create a table map, under the InsightDG folder, right-click and select **Table map > New Table Map.**
In the following window, enter a meaningful name for the Table Map name and click **NEXT**. Next for the Table Map creation, ensure that Locate file in Optim directory is set and the File type is set as Archive and click **Display Files**. Once the list of Archive file is populated, select the file **ORDERS6Y.AF** and click **FINISH**.

Once the Table Map Editor window opens in the right pane, switch to the Table Map tab and select the Tables tab. Under the Target Data Store Alias column for SOURCEDB, select **SOURCEDB** as target, and for XE, select **XE** as the target. Move over to the Target Schema column for SOURCEDB and select **OPTIM** as the schema, and for XE select **OPTIM** as the schema again. Under the Default Target Qualifier column, select only the SOURCEDB row to switch the state from NO to YES. Please remember that to keep things simple here; we used our example to highlight the technical steps.

Staying in the Table tab, select **SOURCEDB** under the Source Data Store Alias tab and scroll down. You will notice that the table names are already pre-filled under the Target Table column. Since we will only restore data back into the deleted **OPTIM_ORDERS** and **OPTIM_DETAILS** tables, we can remove the rest of the table names. So only remove the **OPTIM_CUSTOMERS**,
OPTIM_ITEMS, and OPTIM_SALES and ensure that under the Target Table Status column, it reads Not used for these tables. See the figure below to understand the explanation.

Next, select XE under the Source Data Store Alias tab and scroll down. You will notice that the table names are already pre-filled under the Target Table column. Since we do not need to restore any data back into the XE tables, remove the entries under the Target table column for the two tables. See the figure below to understand the explanation.

**Figure 20. Table Map — Table Map Editor showing tables to delete from**

![Table Map Editor](image)

Ensure to save all your Table Map changes by going to File and selecting Save All.

Now we will actually create the Optim Restore Service. Inside the InsightDG folder, right-click and select Restore Services and choose New Service.

Enter a meaningful name for the Restore Service and click NEXT. Now, click on Display Files and once the list of Archive files get populated, choose the ORDERS6Y.AF Archive file and click FINISH. Once the Restore Service Editor opens, click ADD, which is located next to the Global Selection criteria option located in the top middle area. This is where we will add the condition to restore ORDER_ID 9146 back into the OPTIM_ORDERS and OPTIM_DETAILS tables as per the example restore requirement for this tutorial.

Once the Global Selection Criteria box opens, look under the Column level tab, find the ORDER_ID column and the select "=" operator under the Operator column, and enter 9146 in the Selection Criteria column. Click APPLY and OK.
Back in the Restore Service Editor, select the Archive File tab and select the `ORDERS6Y.AF` archive file, right-click and select **Use Global Selection Criteria**. This will associate the selection condition we defined in the above step.

**Figure 22. Restore Service — Applying global selection criteria**

Next, go back to the Archive File tab and select the file `ORDERS6Y.AF` and click on the **ADD SERVICE** button. Select **Create a local (embedded) insert service** and click **NEXT**.

Finally, Select a table map and once the list of Table Maps is populated, choose the `DG.TABORDERS` and click **FINISH**.
Save all your Restore Service changes by going to File and selecting **Save All**.

**Running an Optim Restore Service using Optim Manager 11.3**

Reopen the Optim Manager browser window and go to the Service Management tab and select the Restore request we just created in the above section (DG.RESTOREORD) and click **ASSIGN SERVER**. Choose your Optim Server and click **OK**. Next, select your Restore Service (DG.RESTOREORD) and click **RUN**. In the next pop-up window, click **RUN** to start the Restore Service job and switch to the Service Monitoring tab and check the status of the Restore Service. Once the service is complete, open and validate the report to ensure that one row was inserted back into both OPTIM_ORDERS and OPTIM_DETAILS.

**Figure 24. Restore Service — Execution report**
Once data has been restored back into the production table, it is always good to verify by running a query to ensure that the row(s) of data were actually inserted back into the respected tables.

**Conclusion**

To recap, we used Optim Designer and Optim Manager to showcase the new data growth functionality in the InfoSphere Optim 11.3 product. We used the self-service features to perform data archiving, used Optim browse to verify the archived data, deleted a subset of the archived data from the OPTIM_ORDERS and OPTIM_DETAILS tables, and restored a particular data back into the production database to answer a customer's inquiry.
Resources

- Learn more by visiting What's New in InfoSphere Optim 11.3.
- Check out InfoSphere Optim Archive to manage data growth effectively to reduce costs and improve performance.
- Learn the basics of how the Optim solutions work through hands-on exercises illustrating how the technology applies to business scenarios by taking the DT225G: Using IBM InfoSphere Optim Solutions for Distributed Platforms course.
- Read about the InfoSphere Optim Data Growth Solution.
- Implementing an InfoSphere Optim Data Growth Solution offers more information.
- Learn more about InfoSphere Optim Data Lifecycle Management Solutions.
- Follow InfoSphere Optim on Twitter.
- Follow developerWorks on Twitter.
About the authors

Pirabu Pathmasenan

Pirabu Pathmasenan, is an IBM Premium Support Manager in the Information Management organization of IBM for DB2 for Linux, UNIX, and Windows, as well as InfoSphere Optim. Prior to this position, Pirabu was a technical leader in the DB2 QA organization where he was responsible for leading, developing, and inventing new tools and processes to improve the quality of the DB2 database product. Pirabu has been with IBM for over 6 years and currently has two papers published on ip.com. He has over 8 years of working experience in the software industry, mainly in software quality assurance and software project management.

Martin Dizon

Martin Dizon is a technical enablement specialist in the Information Management Technology Ecosystem team at the IBM Toronto Software Lab, providing enablement for the IBM Optim and Guardium products. He conducts demonstrations, bootcamps, and skill transfers for worldwide business partners to help accelerate and ensure their success in their own Optim/Guardium projects.